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HTML Guide for the http://www.ic.gc.ca Web Site
Documents that are converted to HTML for the Industry Canada departmental Web site are
transferred to a template in a Lotus Notes Domino database. This site now uses cascading style
sheets, and new Common Look and Feel requirements mean the items below must be observed.

Proofread your HTML coding to ensure that the English matches the French and that both
match the original idea of the printed version. Improperly coded documents will be sent back for
corrections.

It is important to keep the coding as simple as possible!

All HTML pages must be professionally proofread before being sent for posting on the Industry
Canada site.

All final HTML pages, graphics, and PDF files must be sent to Eleanor Szabo
(szabo.eleanor@ic.gc.ca) no later than 5 days before targeted posting date (if it's a big
document — more than 25 pages), or a MINIMUM of 3 days for smaller publications to allow
enough time to load the documents into Lotus Notes, metatag the pages, relink the pages,
repath the graphics, etc.

Please check how pages are layed out for previous corporate publications (e.g. Making a
Difference, Report on Plans and Priorities, and Estimates) located at
http://www.ic.gc.ca/epublications and follow accordingly.
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Dreamweaver MX Settings

For your documents to easily load into Lotus Notes, your Dreamweaver settings must be as
follows:

Under “Edit - Preferences - Code Format”
1. Unclick the “Indent”
2. Set the “Automatic Wrapping - After Column: 1024”
3. Set the “Default Attribute Case” to “lowercase=value”

Under “Edit - Preferences - General”
1. Select “Use <strong> and <em> in place of <b> and <i>”

Coding the Text

A. Cascading Style Sheets

The http://www.ic.gc.ca site uses cascading style sheets (CSS). To code documents,  follow the
CSS coding set up. See Appendix A for the CSS codes used.

Do not set up your own CSS template. We can use only the one we have set up for the IC site.

You may add to the list if you need to but please let me know beforehand what new codes you
need/intend to add so that I can assign a class to it and check that it won’t adversely affect other
Web pages.

B. Do Not Use Deprecated Codes

See the W3C list of deprecated codes at http://www.w3.org/TR/html4/index/attributes.html

Some of the more common ones used that should not be used are:

• <font> codes
This includes formating for font colours, typeface (<font face>), positioning and size.

• <b> or <i> codes for bold and italics
Use <strong> codes in place of <b> for bold text and <em> codes instead of <i> for italic
text. See “Dreamweaver MX Settings” above.

• <bgcolor> for tables
Do not set up the <bgcolor> for tables. This is to be done using CSS.

C. Alignments and Positioning of Text

• Do not use the <center> code or any align codes
This includes using align for <p>, <img>, <div>, <h1>, <img>. To center paragraphs, use
the <p class=”center”> code. The <p class=”right”> will right-justify your text.

• Tables



Do not use tables to position text unless it is a true table. See “Tables” below.

• Don’t misuse the <blockquote> code
Do not use the <blockquote> to indent text. Only use the <blockquote> feature for true
quotations. Below is the correct use of the <blockquote> code:

<blockquote>”In the new, global knowledge economy of the 21st century prosperity
depends on innovation which, in turn, depends on the investments that we make in the
creativity and talents of our people.”</blockquote>
<p>Jean Chrétien, Prime Minister of Canada, <em>Achieving Excellence: Investing in
People, Knowledge and Opportunity</em></p>

D. Use of Underlining/Italics

Underlines
Do not underline text that is not a hypertext link. This includes headings and other text in
paragraphs. If you come across a word (or phrase) that is underlined and is not a link, switch it to
bold (<strong>) instead. 

Italics

Italics should be coded as <em> and not <i>. 

Do not use italics to emphasize a word (use <strong> instead).

Italicize the titles of books, pamphlets, published reports and studies, films, most works of art
(novels, plays, paintings, long musical compositions, and so on), newspapers, magazines and
other periodicals.

It is not necessary to italicize or put in quotation marks the names of Web sites, such as
Strategis and ICWeb.

Italicize the complete names of acts, statutes and court cases.

Use italics for French or foreign words and phrases that are not considered to be Anglicized.
Some common words and phrases that are considered to be Anglicized and that do not take
italics are ad hoc, aide-de-camp, per capita, regime and sombrero.

In general, it is not necessary to italicize legal terms, especially familiar ones.

Do not italicize headings unless the heading happens to be a government act, title of a book or
one of the items listed above. 

Do Not: <h3><em>Electronic Commerce</em></h3>
Do: <h3>Electronic Commerce</h3>



E. Headings

Use the <h> codes correctly. Use <h1> for the top-level headings, followed by <h2>, <h3>, <h4>,
etc. Many users rely on the correct presentation order of the <h> tags to navigate documents. 

<h1> This is the top-level heading </h1> 
<h2> This is the second-level heading </h2>
<h3> This is the third-level heading </h3>
<p>This is the paragraph.</p>

Do not use <strong> or <bold> codes with any <h> codes as this feature is already built into the
Cascading Style Sheet.

Do Not: <h1><strong>Top-Level Heading</strong></h1>
Do:        <h1>Top-Level Heading</h1>

F. Full Capitalization

Never put any items in FULL CAPITALIZATION LIKE THIS.

G. Footnotes

Footnotes should appear at the bottom of the page and be coded with the following:
<p class=”footnote”>Footnote text.</p> 

Alternatively, you can create a page containing all the notes and link there.

H. Clean Coding

Keep the coding as clean as possible and avoid unnecessary extra codes. Ensure that all
opening tags have corresponding closing tags.

I. Bulleted Lists

Bulleted text should be coded using the proper <ul> (or <ol>) and <li> codes. Make sure you
have spaces in between bullets if the text is long by using two <br> codes after each </li>. For
example:

<ul><li>item 1</li><br><br>
<li>item 2</li><br><br>
<li>item 3</li></ul>

Do not use graphics for bullets.

Do not use tables to create a bulleted list (or create a table within a table).



J. Lower-Case HTML Coding

Ensure that all HTML codes are in lower-case. See “Dreamweaver MX Settings” above.

K. Acronyms/Abbreviations

Use the acronym and abbreviations code to mark up the text. Acronyms generally contain the
first letter of each word whereas abbreviations are a shortened version of a word.

Code every occurrence of an acronym/abbreviation, not just the first instance.

A list of the most popular acronyms used at Industry Canada can be found at
http://www.ic.gc.ca/cmb/welcomeic.nsf/ICPages/Acronyms

Dreamweaver MX Tip: 
To add Acronyms/Abbreviations, from your drop-down menu bar, go to “Insert - Text Objects -
Acronyms (or) Abbreviations”

Acronyms
<acronym title=”Community Access Program”>CAP</acronym>
<acronym title=”Canadian Network for the Advancement of Research, Industry and
Education”>CANARIE</acronym>
<acronym title=”Aboriginal Business Canada”>ABC</acronym>
<acronym title=”Canadian Space Agency”>CSA</acronym>

Acronyms – Changing Language

Sometimes an English acronym appears in French text and vice versa. To code for this, include
the “lang” feature with the acronym title tag. For example:

Le projet de <acronym title="Research in Motion" lang="en">RIM</acronym> permettra
de cr&eacute;er ou de conserver plus de 800&nbsp;emplois tr&egrave;s
sp&eacute;cialis&eacute;s.

Abbreviations
<abbr title=”Street”>St.</abbr>
<abbr title=”Ontario”>Ont.</abbr>
<abbr title=”Doctor”>Dr.</abbr>
<abbr title=”Saint”>St.</abbr> Johns



L. Hard-Coded Spaces

Ensure that certain items such as dates, names, numbers, percentages, etc., do not get
separated at the end of a line. Use the hard code (&nbsp;) to create a hard space to keep items
together. For example:

45&nbsp;percent
Bob&nbsp;Smith
10&nbsp;000
10&nbsp;p.&nbsp;100
le&nbsp;3&nbsp;septembre&nbsp;2003
10&nbsp;000&nbsp;$
Renseignements&nbsp;: (before colons in French text)
«&nbsp;Ce soutien financier permettra &agrave; notre industrie de mieux se faire
conna&icirc;tre et ainsi de mettre en valeur la qualit&eacute; des produits et services
con&ccedil;us ici, par des gens d'ici&nbsp;» (with French quote marks)

Dreamweaver MX Tips: 
Use “Ctrl-Shift-Spacebar” to create a hard-coded space (&nbsp;). 
A “shift-enter” will create a <br> code.

M. Other Language Text (<span lang>)

Clearly identify changes in the natural language of a document’s text by using the “lang”
attribute. For English it’s <span lang=”en”>English text</span> and for French it’s <span
lang=”fr”>French text</span>. For example:

<p>To learn more about the <span lang=”fr”>Francommunautés virtuelles</span>
program, visit
<a href=”http://francommunautes.ic.gc.ca”>http://francommunautes.ic.gc.ca</a>.</p>

See http://www.oasis-open.org/cover/iso639a.html for a listing of language codes.

N. Page Lengths

Ensure that page lengths are not too long. Separate the publication into manageable page sizes
(Web pages should be no more than about 10 printed pages maximum). Separate the document
into logical groups (e.g. Section A on one page, Section B on another, etc.).

O. Special Characters

Use the proper codes to create special characters.

Dreamweaver MX Tip: 
Special characters can be found under “Insert - Special Characters - Other . . . ”. For example:

2. Ellipsis (. . . ) should be coded with &#133; or &#8230; (do not put three periods)
4. Em dashes (—) should be coded with &#151; or &#8212;
6. En dashes (–) should be coded with &#150; or &#8211;
8. Trademark symbols (™) should be coded with &#8482;



10. Copyright symbols (©) should be coded with &copy;
12. Registered trademark (®) should be coded with &reg;
14. Ampersand (&) should be coded with &amp;
16. Quotation marks (“) should be coded with &quot;

All French accented letters should have the proper HTML codes. (Note: The text must be pasted
in the third window of Dreamweaver titled “Show Design View” for the accented letters to convert
properly.) 

P. Superscripts

Be sure to use the <sup> code where necessary. For example:

le 1<sup>er</sup> avril 2003 to create le 1er avril 2003 
21<sup>st</sup> Century to create 21st Century

Dreamweaver MX Tip: 
To create a <sup> code in Dreamweaver, highlight the text and click “Ctrl” and “t” at the same
time, in the coding window, type in <sup>. 

Q. Horizontal Rules

Note that the “noshade” attribute of the <hr> code is deprecated and cannot be used.

Dreamweaver MX Tip: 
To create a <hr>, go to “Insert - Horizontal Rule.”



Links

1. Links to certain programs, sectors, government acts, etc., are required. See
http://www.ic.gc.ca/links for a complete listing.

2. Do not make links bold (this includes e-mail addresses).

3. Do not use “target=_menu” or “target=_blank” to open links in a new window.

4. Make sure your links make sense. Do not code “Click here” as a link, for example.

5. Try as much as possible to link to actual words rather than placing links in brackets after. 

Do Not: The scope of SchoolNet (<a href=”http://www.schoolnet.ca”>
http://www.schoolnet.ca</a>) encompasses three programs: First Nations, GrassRoots
and Network of Innovative Schools.           
Do: The scope of <a href=”http://www.schoolnet.ca”>SchoolNet</a> encompasses three
programs: First Nations, GrassRoots and Network of Innovative Schools.

6. Use English URLs for English links and French URLs for French links.

Do Not: <a href=”http://www.rescol.ca”>SchoolNet</a>
Do: <a href=”http://www.schoolnet.ca”>SchoolNet</a>



Graphics

A. Use Only Web-Safe Colours for Graphics

When creating any graphics, make sure to use only the 216 Web-safe colours. See
http://www.cio-dpi.gc.ca/clf-upe/216_e.asp for a listing. The common colours we use on our site
are:

Blue: 336699 
Red: CC0000
Dark Grey: 666666
Light Grey: CCCCCC
Tip: Any colour that contains any combination of 0,3,6,9,C or F is automatically Web-safe. Those
that don’t, are not.

B. Coding Graphics

1. All graphics must be coded with width, height and alt tags.

2. Alt tags must be in English when placed in English text and in French for French text. 

3. All images must have meaningful alt tags. Don’t just put in “Figure 1.” Include the whole title.

4. The maximum length for an alt tag is 150 characters.

5. Alt tags for lines or other non-important graphics should be coded as alt=”“ (no space between
the quotes).

6. An example of a properly coded graphic is:

<img src="/cmb/welcomeic.nsf/vRTF/Footers/$file/footpe.gif" width="90" height="25"
alt="Previous">

C. Positioning Graphics

You can use the Cascading Style Sheets to position graphics justified left or right.

Left-justified Graphics: 
<img src="../images/img_collage_smPlan.gif" width="115" height="133" class="leftimage"
alt="">

Right-justified Graphics:
<img src="../images/img_collage_smPlan.gif" width="115" height="133" class="rightimage"
alt="">



C. Widths for Graphics/Tables

Do not use widths of over 450 pixels for tables, charts or graphics unless there is absolutely no
way to avoid it. Even then, the maximum should be no more than 600 pixels.

If the graphic is more than 450 pixels wide, create a thumbnail and link to the larger graphic from
this.

D. Images

“<Img Src>” Addresses
When providing images (gifs, jpgs, etc.), put them in a folder called “Images” for easy reference.
(It helps if you have one folder for the English graphics and another for the French.) 

Other Items

A. Cover Page

If possible, a jpg of the cover of the publication should appear at the top of the first page (about
216 × 280 pixels). Also, the title of the publication along with the necessary disclaimers, File
Numbers, additional copies note, etc., should appear here. 

B. Footer

The footer of each page should contain at least links to:

Contents Page   Next Page

Adobe Acrobat (PDF) Files

1. All publications must at least be provided in HTML. PDF versions are optional, as they are not
truly accessible and should be used only as a secondary alternative to accessible HTML.

2. If PDF files are included, code them to be as accessible as possible.

3. Adobe Acrobat files are to be linked from the cover page or from the contents page.

4. Do not use the PDF graphic, as third-party icons are not allowed.

5. Name French PDFs with French names and English ones with English names. Do not include
spaces in the file names.

6. Links to PDF files should be coded as follows:

English:

Adobe Acrobat Version (PDF - file size - X pages)

<p><strong>Note:</strong> to read the <acronym title=”Portable Document



Format”>PDF</acronym> version, you need <a
href="http://www.adobe.com/products/acrobat/readstep2.html">Adobe Acrobat Reader</a> on
your system. If the Adobe download site is not accessible to you, you can <a
href="http://www.adobe.com/products/acrobat/readstep.html">download Acrobat Reader</a>
from an accessible page. If the accessibility of <acronym title=”Portable Document
Format”>PDF</acronym> is a concern, you can have the file converted to <acronym
title="HyperText Markup Language">HTML</acronym> or <acronym title="American Standard
Code for Information Interchange">ASCII</acronym> text by using one of the <a
href="http://access.adobe.com/">access services</a> provide by Adobe.</p>

French:

Version Adobe Acrobat (PDF - file size - X pages)

<p><strong>Remarque</strong> : Pour lire la version <acronym title="format de document
portable">PDF</acronym>, vous avez besoin de t&eacute;l&eacute;charger le logiciel <a
href="http://www.adobe.fr/products/acrobat/readstep2.html"><span lang=”en”>Adobe Acrobat
Reader</span></a> sur votre syst&egrave;me. Si vous n'avez pas acc&egrave;s au site de
t&eacute;l&eacute;chargement d'Adobe, vous pouvez <a
href="http://www.adobe.fr/products/acrobat/readstep.html">t&eacute;l&eacute;charger le logiciel
<span lang="en">Acrobat Reader</span></a> &agrave; partir d'une page accessible. Si
l'accessibilit&eacute; &agrave; un document <acronym title="format de document
portable">PDF</acronym> pose un probl&egrave;me, vous pouvez convertir le fichier en format
texte <acronym title="HyperText Markup Language" lang="en">HTML</acronym> ou <acronym
title="American Standard Code for Information Interchange" lang="en">ASCII</acronym> en
utilisant l'un des <a href="http://access.adobe.com/">services d'acc&egrave;s</a> offerts par
Adobe.</p>

Tables

A. Keep the Use of Tables to an Absolute Minimum

Only use tables for actual tables. Never use tables for content placement or to make bulleted
lists.

B. Do Not Scan Tables as Graphic Files

Do not scan tables as .gifs or .jpgs as these cannot be read by screenreaders. All tables must be
done using the coding noted below to make them accessible. 

C. How to Create Accessible Tables

When coding HTML data tables for accessibility, there are certain guidelines that must be
followed. For example:

1. Column headers and row headers must be identified using <th> tags instead of <td>
tags.
The default style for headers within <th> tags is bold and centred — this can be changed using
styles and/or the “align” attribute in your <th> tag (just as you would use it in a <td> tag).



2. <caption> tags must be used to give your table a label, or name. 
Default styles for data within <caption> tags can also be changed using styles (see below).

3. Header cells must be associated with their respective data cell(s).
There are different ways to associate headers with data cells. The method you use will depend
on the type of data table you are coding (see below).

A full list of guidelines for creating accessible data tables can be found at
http://www.yourhtmlsource.com/tables/tablesaccessibility.html and
http://www.w3.org/WAI/wcag-curric/sam43-0.htm 

Linear Tables

A linear table has one row of header cells at the top and can be read easily from left to right.
These tables can be coded as a normal table; no special coding is required. An example follows:

Name Address Telephone

Joe Smith 111 Queen Street (613) 555-1111

Jane Doe 200 Bank Street (613) 555-2222

John Brown 500 King Street (613) 555-3333

Source code:

<table width="450" border="1" cellspacing="2" cellpadding="6">
<tr><td><strong>Name</strong></td>
<td><strong>Address</strong></td>
<td><strong>Telephone</strong></td></tr>
<tr><td>Joe Smith</td>
<td>111 Queen Street</td>
<td>(613) 555-1111</td></tr>
<tr><td>Jane Doe</td>
<td>200 Bank Street</td>
<td>(613) 555-2222</td></tr>
<tr><td>John Brown</td>
<td>500 King Street</td>
<td>(613) 555-3333</td></tr>
</table>

Simple Tables

A simple table generally has one row of header cells at the top of the table and one column of
header cells in the left-most column of the table. In the example below, data cells can be
associated with their respective header cells by using the “scope” attribute within the <th> cell.

Example: <th scope=”col”>January</th> or <th scope=”row”>Sales</th>. This code
associates all data within the “January” column to the header “January,” and all data within the
“Sales” row to the header “Sales.”



Profit and Loss for 2002
January February

Sales 5000 (5000) 10 000

Expenses 2500 3500

Profit 2500 6500

Source code:

<table width="450" border="1">
  <caption>Profit and Loss for 2002</caption>
  <tr> 
    <th>&nbsp;</th>
    <th scope="col">January</th>
    <th scope="col">February</th>
  </tr>
  <tr> 
    <th scope="row">Sales</th>
    <td>5000</td>
    <td>10&nbsp;000</td>
  </tr>
  <tr> 
    <th scope="row">Expenses</th>
    <td>2500</td>
    <td>3500</td>
  </tr>
  <tr> 
    <th scope="row">Profit</th>
    <td>2500</td>
    <td>6500</td>
  </tr>
</table>



Complex Tables

Complex tables usually have more than one row of headers within the table, or more than one
column of headers. In the table below, row number one (Sales for January) uses a colspan=3 to
span all columns in the table. Row number two has three column headers (or sub-headers)
associated with row one’s header, and in turn row number three has header and data cells that
are associated with the two rows above it. This makes it difficult to use the “scope” attribute.
Instead we use the “id” and “headers” attributes. Headers are given an “id” name, and all
associated header/data cells are given a “headers” name, which associates with that header’s
“id.” For example:

<tr>
<th colspan=”3" id=”sales_jan”>Sales for January</th>
</tr>

 <tr>
<th headers=”sales_jan”>Year</th>
<th headers=”sales_jan”>2001</th>
<th headers=”sales_jan”>2002</th>
</tr>

Screenreaders read table cell contents starting top-to-bottom, left-to-right, like we would read a
book. When using “id” and “headers” attributes, screenreaders would associate table headers
with their respective table data contents, and would read contents from the above example as:

Sales for January: Year, Sales for January: 2001, Sales for January: 2002

Note: A data cell can be associated with one or more header cells (so data cells may have more
than one “headers” associations). For example:

This data cell: <td headers="profit sales"> refers to two header cells: <th id=”profit”>
and <th id=”sales”>

Sales for January and February
Sales for January

Year 2001 2002

Profit 100 000 200 000

     Sales for February

Year 2001 2002

Profit 150 000 150 000

Sales for Both Months

Total Profit 250 000 450 000



Source code:

<table width="450" border="1">
 <caption>Sales for January and February</caption>
  <tr> 
    <th colspan="3" id="sales_jan">Sales for January</th>
  </tr>
  <tr> 
    <th align="left" id="year_jan" headers="sales_jan">Year</th>
    <th id="jan_2001" headers="sales_jan year_jan">2001</th>
    <th id="jan_2002" headers="sales_jan year_jan">2002</th>
  </tr>
  <tr> 
    <th align="left" id="profit_jan" headers="sales_jan">Profit</th>
    <td headers="profit_jan sales_jan jan_2001">100&nbsp;000</td>
    <td headers="profit_jan sales_jan jan_2002">200&nbsp;000</td>
  </tr>
  <tr> 
    <th colspan="3" id="sales_feb">Sales for February</th>
</tr>
  <tr> 
    <th align="left" id="year_feb" headers="sales_feb">Year</th>
    <th id="feb_2001" headers="sales_feb year_feb">2001</th>
    <th id="feb_2002" headers="sales_feb year_feb">2002</th>
  </tr>
  <tr> 
    <th height="25" align="left" id="profit_feb" headers="sales_feb">Profit</th>
    <td headers="profit_feb sales_feb feb_2001">150&nbsp;000</td>
    <td headers="profit_feb sales_feb feb_2002">250&nbsp;000</td>
  </tr>
  <tr> 
    <th colspan="3" id="total_both">Total for both Months</th>
</tr>
  <tr> 
    <th align="left" id="total_profit" headers="total_both">Total Profit</th>
    <td headers="total_profit total_both feb_2001">250&nbsp;000</td>
    <td headers="total_profit total_both feb_2002">450&nbsp;000</td>
  </tr>
</table>

Making HTML Tables Accessible Using LIFT Extension for Dreamweaver

1. Open a table in Dreamweaver and select Design View (Menu: View > Design).

2. Open the LIFT Fix Wizard (from within Dreamweaver — Menu: LIFT > Fix Wizard...).

3. Select the HTML table while in Design View by clicking on the corner of the table when your “I”
bar turns into four arrows (when selected, the table will have a thick black box around it).

LIFT will detect the type of HTML table — simple or complex.  The LIFT Wizard provides the
following entry fields:

A. Simple Tables



Summary: Enter a description of the table’s purpose which is not visible by the browser (but is
recognized by screenreaders).

Caption: Enter the title of the table here (e.g. Table 1 - Profit and Loss for 2002).

Three Checkboxes (click beside the three checkboxes and click “Apply”):
18. Transform first row into Header Cells.
20. Transform first column into Header Cells.
22. Add “SCOPE” to Header Cells. When you check this option, LIFT adds the “scope” attribute
as well as the scope type (row or column).

B. Complex Tables

Identifying Header Cells

The first step is to select all the cells that will be headers by holding down the “Ctr” key and
clicking in the cells to be marked as header cells. With your “LIFT - Fix Wizard” screen open,
click “Transform Data Cells into Header Cells” and click “Apply.”

Next, select the HTML table while in Design View by clicking on the corner of the table when
your “I” bar turns into four arrows (when selected, the table will have a thick black box around it).
In the “Fix Wizard” window, you will see the following items:

Summary: Enter a description of the table’s purpose. This is not visible with the browser, but is
recognized by screenreaders.

Caption: Enter the title of the table here (e.g. Table 1 - Profit and Loss for 2002).

Assigning a Unique ID for Each Cell / Binding Internal Cells to Their Header Cells

The next step is to assign the ID attributes to header cells. This is required to create the
association between the header cells and internal cells. Also, you need to bind internal cells to
their respective header cells. This can be accomplished by using the “LIFT - Fix Wizard” when
the entire table is selected. Simply click the two checkboxes shown below and click “Apply.” 

Two Checkboxes
24. Add IDs to Header Cells.
26. Assign computed “HEADERS” attributes to cells.

LIFT — Customize Guidelines

Before doing an evaluation check on your tables, you can customize the results by going to
“Customize Guidelines.” Ensure the following are set for testing tables (you may wish to have
more if you’re testing whole pages):

Tables (set to ALL)
W3C WCAG Accessibility Priority 1 (set to ALL)
W3C WCAG Accessibility Priority 2 (set to ALL)

You can enable and disable guidelines by selecting the item and clicking on the green
checkmark to enable it or the red X to disable it. You may want to disable guidelines that are not
required to reduce the number of false errors in your report.



LIFT — Evaluate

After making your selection options and running the Wizard, you should run an evaluation check
on the new code. This can be done in the following way:

28. From the drop-down menu, select LIFT > Evaluate.
30. Under the “Evaluate” tab/folder, choose “Current Document” in the “Page(s):” field.
32. In the “Guidelines” field, choose “Tables Tests.”
34. Click “Run.”
36. Results will be shown in the bottom frame. For more information on any warning shown, click
on the “Explain Issue” button at the bottom.

The evaluate tool will tell you where you may have some association errors. Usually the errors
are only warnings to double-check your associations.

Checking Cell Associations

You can check and modify the headers associations. While the LIFT Wizard is open, select an
individual table data cell by holding the “Shift” key down and clicking in the cell. You will see a
thicker black box around it.

In the “Table Cell” box, you will see a field called “Refers to,” which will list the columns and rows
the cell is associated with.



Appendix A: Cascading Style Sheets

BODY { background: #FFFFFF;
font-size : .8em;
color: #000000; 
font-family: arial, helvetica, sans-serif;}

select.wide { font-family: arial narrow, arial, helvetica, sans-serif;}
table.index { background-color: #EEEEEE; 

border-left: 1px solid #EEEEEE; 
border-top: 1px solid #EEEEEE; 
border-right: 1px solid #CCCCCC; 
border-bottom: 1px solid #CCCCCC;
margin-bottom: 10px; }

td.index    { background-color: #FFFFFF; 
border-left: 1px solid #CCCCCC; 
border-top: 1px solid #CCCCCC; 
border-right: 1px solid #EEEEEE; 
border-bottom: 1px solid #EEEEEE; }

P {font-size: 100%; font-family: arial, helvetica, sans-serif; }
.white {font-size: 100%; font-family: arial, helvetica, sans-serif; font-weight: bold; color: #FFFFFF;}
.red {font-size: 100%; font-family: arial, helvetica, sans-serif; font-weight: bold; color: #CC0033;}
.header { font-size : 110%; font-family: arial, helvetica, sans-serif; font-weight: bold; color: #666666;}
.subheader { font-size : 110%; font-family: arial, helvetica, sans-serif; font-weight: bold; color: #DD0000;}
.small { font-size : 90%; font-family: arial, helvetica, sans-serif;}
.smallbold { font-size : 90%; font-family: arial, helvetica, sans-serif; font-weight: bold;}
.smaller { font-size : 85%; font-family: arial, helvetica, sans-serif;}
.smallerbold { font-size : 85%; font-family: arial, helvetica, sans-serif; font-weight: bold;}
.callout { font-size : 90%; color: #003366; font-family: arial, helvetica, sans-serif;}
.center { text-align: center; font-size: 100%; font-family: arial, helvetica, sans-serif;}
.right { text-align: right; font-size: 100%; font-family: arial, helvetica, sans-serif;}
.footnote {font-family: arial, helvetica, sans-serif; font-size: 8pt; color: #666666; font-style: normal;}

TD { font-size: 80%; font-family: arial, helvetica, sans-serif; }
caption {font-size: 100%; font-family: arial, helvetica, sans-serif; font-weight: bold;}

TR.grey { font-size: 100%; font-family: arial, helvetica, sans-serif; background-color: #CCCCCC }
TR.black {  font-size: 100%; font-family: arial, helvetica, sans-serif; background-color: #000000 }

TH {text-align: left; font-size: 80%; font-family: arial, helvetica, sans-serif; font-weight: normal;}
.left {font-size: 80%; font-family: arial, helvetica, sans-serif; text-align: left;}
.left_nobold {text-align: left; font-size: 80%; font-family: arial, helvetica, sans-serif;}
.nobold {font-size: 80%; font-family: arial, helvetica, sans-serif;}

IMG { border: 0; border-style: none; }

.rightimage {
border: 0; 
float : right;
 }

.leftimage {
border: 0; 
float : left;
}



SUP {font-size : 80%; font-family: arial, helvetica, sans-serif;}

UL { list-style: square; font-size: 100%; font-family: arial, helvetica, sans-serif; margin-bottom: 0%; }

UL.ciob { list-style-image: url(/images/bltpurple.gif); margin-left: 15px; margin-bottom: 0; }
UL.alphalist {  list-style-type: lower-alpha; font-family: arial, helvetica, sans-serif; color: #000000;}
UL.menu { list-style: square; font-size : 85%; font-family: arial, helvetica, sans-serif; margin-bottom: 0%; }
OL  { list-style: numbers;  font-size: 100%; font-family: arial, helvetica, sans-serif;}

acronym { color: #666666 }

.nav { text-decoration: none; }

.drop { font-family: arial, helvetica, sans-serif; color: #660066; }

.box { border: thin solid outset #000000; }

/* label { font-weight: bold; text-decoration: underline; } */

div.Q { color: #660066;   font-weight: bold; }
div.compact { display: compact; margin-left: 2em; }

input { font-family: arial, helvetica, sans-serif; font-size: 1em; }

A:active { color: #666666; }
A:link { color: #003366; }
A:visited { color: #336699; }
A:hover { color: #336699; }
A.hide { display: none; }

a.common { width: 100%; 
background: #000000;
color: #FFFFFF;
text-decoration: none; 
font-weight: bold; }

a.common:visited { background: #000000;
color: #FFFFFF; }

a.common:hover { height: 100%; background: #000000; 
color: #FFFFFF; }

a.inst { width: 100%; 
color: #FFFFFF;
text-decoration: none; 
font-weight: bold; }

a.inst:visited { width: 100%; 
color: #FFFFFF;
text-decoration: none; 
font-weight: bold; }

a.inst:hover { height: 100%;
width: 100%; 
color: #CCCCCC;
text-decoration: none; 
font-weight: bold; }

a.default { width: 100%;



height:100%; 
padding: 3px;
background: #FF0000;
color: #FFFFFF;
text-decoration: none; 
font-weight: bold; 
border: solid;
border-width: thin;
border-top-color: #FF6666; 
border-left-color: #FF6666; 
border-right-color: #990000;
border-bottom-color: #990000; }

a.default:visited { width: 100%;
height: 100%;
padding: 3px; 
background: #FF0000;
color: #FFFFFF;
border: solid;
border-width: thin;
border-top-color: #FF6666; 
border-left-color: #FF6666; 
border-right-color: #990000;
border-bottom-color: #990000; }

a.default:hover { width: 100%;
height: 100%; 
padding: 3px;
background: #FF0000; 
color: #FFFFFF;
border: solid;
border-width: thin;
border-top-color: #990000; 
border-left-color: #990000; 
border-right-color: #FF6666;
border-bottom-color: #FF6666; }

H1   { font-size: 125%; font-family: arial, helvetica, sans-serif; Margin-bottom: 8px; padding: 0px; color:
336699}
.t1  { font-size: 125%; font-family: arial, helvetica, sans-serif; font-weight: bold; text-decoration: none; }

H2  { font-size: 110%; font-family: arial, helvetica, sans-serif; margin: 0em; padding: 0em;}
.t2  { font-size: 110%; font-family: arial, helvetica, sans-serif; font-weight: bold; text-decoration: none; }

H3   { font-size: 105%; font-family: arial, helvetica, sans-serif; Margin-bottom: 10px; color: CC0033}
.t3  { font-size: 105%; font-family: arial, helvetica, sans-serif; font-weight: bold; text-decoration: none; }

H3.site { background: #FFFFFF;
border-right: 1px solid #CCCCCC;
color: #000000;
margin-bottom: 0px;
margin-top: 0px;
text-decoration: none; }

H3.pres { text-transform: uppercase; 
border-left: 5px solid #660066; 
border-bottom: 1px solid #CCCCCC; 
padding-left: 3px;



padding-top: 3px;
padding-bottom: 3px;
margin-bottom: 0px;
margin-top: 0px;
text-decoration: none; }

H4.subsite { background: #FFFFFF;
color: #660066;
border-bottom: 1px solid #CCCCCC; 
border-right: 1px solid #CCCCCC;
padding-left: 3px;
padding-top: 3px;
padding-bottom: 3px;
margin-bottom: 0px;
margin-top: 0px;
text-decoration: none; }

H4 { font-size: 100%; font-family: arial, helvetica, sans-serif; Margin-bottom: 10px; }

.t4 { font-size: 100%; font-family: arial, helvetica, sans-serif; font-weight: bold; text-decoration:
none; }

H5  { font-size: 100%; font-family: arial, helvetica, sans-serif; Margin-bottom: 10px; ; color: 666666}

.calSearch {  font-size: 100%; font-family: arial, helvetica, sans-serif; text-decoration: none; }

H4.pres { text-transform: uppercase; 
border-left: 5px solid #660066; 
border-bottom: 1px solid #CCCCCC; 
padding-left: 3px;
padding-top: 3px;
padding-bottom: 3px;
margin-bottom: 0px;
margin-top: 0px;
text-decoration: none; }

div.pres { width: 132px;
padding-left: 8px;
border-right: 1px;
border-left: 0px;
border-top: 0px;
border-bottom: 0px;
border-style: solid;
border-color: #CCCCCC; }

.notice {background: #FFFF00; }

.sidelink { font-size: 11px; text-decoration: none }

.sidelink:visited { color : #660066; }

A.sb1 { text-decoration : none; width : 100%; }
A.sb1:visited { text-decoration : none; width : 100%; }
A.sb1:hover { text-decoration : none; width : 100%; }

/* NEW NEW NEW JULY 11, 2001 */

a.buttonpurple:link { width: 100%; color: #FFFFFF; background: #660066; border: solid; border-width:
1px;



  border-top-color: #CC66CC; border-left-color: #CC66CC; 
  border-right-color: #330033; border-bottom-color: #330033; 
  margin: 0px; padding: 2px; text-decoration: none; }

a.buttonpurple:visited { width: 100%; color: #FFFFFF; background: #660066; border: solid; border-
width:1px;

  border-top-color: #CC66CC;  border-left-color: #CC66CC; 
  border-right-color: #330033; border-bottom-color: #330033; 
  margin: 0px; padding: 2px; text-decoration: none; }

a.buttonpurple:hover { width: 100%; color: #FFFFFF; background: #660066; border: solid; border-width:
1px;

  border-top-color: #330033; border-left-color: #330033; 
  border-right-color: #CC66CC; border-bottom-color: #CC66CC; 
  margin: 0px; padding: 2px; text-decoration: none; }

a.btsubweb:link { width: 100%; color: #FFFFFF; background: #660066; border: solid; border-width: 1px;
border-top-color: #CC66CC; border-left-color: #CC66CC; 
border-right-color: #330033; border-bottom-color: #330033; 
margin: 0px; padding: 2px; text-decoration: none; }

a.btsubweb:visited { width: 100%; color: #FFFFFF; background: #660066; border: solid; border-width:1px;
border-top-color: #CC66CC;  border-left-color: #CC66CC; 
border-right-color: #330033; border-bottom-color: #330033; 
margin: 0px; padding: 2px; text-decoration: none; }

a.btsubweb:hover { width: 100%; color: #FFFFFF; background: #660066; border: solid; border-width: 1px;
border-top-color: #330033; border-left-color: #330033; 
border-right-color: #CC66CC; border-bottom-color: #CC66CC; 
margin: 0px; padding: 2px; text-decoration: none; }

td.button { background: #EEEEEE; 
border-top: solid 1px #FFFFFF;
border-left: solid 1px #FFFFFF; 
border-right: solid 1px #FFFFFF; }

td.btsubweb { width: 100%; background: #660066;
border-top: solid 1px #660066;
border-left: solid 1px #660066;
border-right: solid 1px #660066; }

/* END NEW */

a.button:link { width: 100%; color: #660066; background: #EEEEEE; border: solid; border-width: 1px;
border-top-color: #FFFFFF; border-left-color: #FFFFFF; 
border-right-color: #CCCCCC; border-bottom-color: #CCCCCC; 
margin: 0px; padding: 2px; text-decoration: none; }

a.button:visited { width: 100%; color: #666600; background: #EEEEEE; border: solid; border-width:1px;
border-top-color: #FFFFFF;  border-left-color: #FFFFFF; 
border-right-color: #CCCCCC; border-bottom-color: #CCCCCC; 
margin: 0px; padding: 2px; text-decoration: none; }

a.button:hover { width: 100%; color: #FF0000; background: #EEEEEE; border: solid; border-width: 1px;
border-top-color: #CCCCCC; border-left-color: #CCCCCC; 
border-right-color: #FFFFFF; border-bottom-color: #FFFFFF; 
margin: 0px; padding: 2px; text-decoration: none; }



a.button2 { color: #000000; border: 2px outset; margin: 0px; 
padding-left: 2em; padding-right: 2em;  padding-top: 2px;  padding-bottom: 2px; 
text-decoration: none; float: right; }

a.button2:visited  {color: #000000; border: 2px outset; margin: 0px;
padding-left: 2em; padding-right: 2em; padding-top: 2px; padding-bottom: 2px;
text-decoration: none; float: right; }

a.button2:hover { color: #000000; border: 2px inset; margin: 0px;
padding-left: 2em; padding-right: 2em; padding-top: 2px; padding-bottom: 2px;
text-decoration: none; float: right;  }

@media print {
page         { margin: 10% }
H1, H2, H3,
H4, H5, H6    { page-break-after: avoid; page-break-inside: avoid }
BLOCKQUOTE, 
UL, OL, DL    { page-break-before: avoid }  }
@media aural {
H1, H2, H3, 
H4, H5, H6    { voice-family: paul, male; stress: 20; richness: 90 }
H2            { pitch: x-low; pitch-range: 80 }
H3            { pitch: low; pitch-range: 70 }
H4            { pitch: medium; pitch-range: 60 }
H5            { pitch: medium; pitch-range: 50 }
H6            { pitch: medium; pitch-range: 40 }
LI, DT, DD    { pitch: medium; richness: 60 }
DT            { stress: 80 }
B, STRONG     { pitch: medium; pitch-range: 60; stress: 90; richness: 90 }
I             { pitch: medium; pitch-range: 60; stress: 60; richness: 50 }
U             { richness: 0 }
A:link        { voice-family: harry, male }
A:visited     { voice-family: betty, female }
A:active      { voice-family: betty, female; pitch-range: 80; pitch: x-high }  }



Appendix B: Checklist

G Confirm that the ISBN, IC registration number and catalogue number are specific to the
HTML version.

G Ensure that the copyright text is specific to the HTML version. See
http://icnet.ic.gc.ca/publication/english/style/guide_presentation_front-prelim_sample-exe
mple_e.html for a sample.


